Lab: AWS Lambda Function for
Open Al API

Lab overview and objectives

In this lab, you will create an AWS Lambda function using Python that will call Open
Al APIs.

After completing this lab, you should be able to:

o Create a Python based AWS Lambda function from the AWS Management
Console that will call Open Al APIs.

o Create an AWS Lambda layer.

o Test the functions from AWS Lambda Test tab.

o Execute the functions from a Web Browser using Function URL.

o Execute the functions from and HTML page using Function URL.

o Create a DynamoDB table to keep conversation history.

e Enhance the Lambda API and HTML to support chat history.
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Scenario

You will create a Lambda function that receives a JSON payload with three parameters
in the request body (instead of query parameters in GET). Based on these parameters,
a calculation will be performed, and the result will be returned as a JSON response.

Accessing the AWS Management Console

For this lab we will use the AWS Academy learner lab and will be using the AWS
Management Console.

Task 1: Create Python chat using Open Al
API

In this task, you will write a Python program that interacts with the OpenAl API to generate
responses based on user input. You will also learn about the API key and how it is used in
the context of the OpenAl API.

The API key is a unique identifier used to authenticate requests associated with your
OpenAl account. It is essential to keep your API key secure and not expose it in public
repositories or client-side code. In this task, you will use the API key to initialize the OpenAl
client.

1. Write the next python code:
o Importthe OpenAl library:
1. Start by importing the "OpenAl " class from the “openai™ module.
o Initialize the OpenAl client:
1. Create an instance of the "OpenAl " client using your API key.
o Set up the conversation history:
1. Initialize an empty list to store the conversation history.
o Create a loop to interact with the user:
1. Use a ‘while " loop to continuously prompt the user for input until they type 'exit’.
2. Append each user input to the conversation history.
o Generate a response from the Al:
1. Use the ‘responses.create * method of the OpenAl client to generate a response
based on the conversation history.
o Printthe Al's response:
1. Print the Al's response to the console.
2. Append the Al's response to the conversation history.
o Use a low-cost model like ‘gpt-4.1-nano’ model



Note about the conversation history: This conversation history is stored only
in memory and will reset every time the Lambda function is invoked. In later
tasks, we will store chat history in DynamoDB so that the Lambda function
can remember previous interactions and pass them to OpenAl.

2. Alternatively, use the following code, make sure to replace
with your own key:

from openai import OpenAIl
client = OpenAlI ( ="YOUR API KEY")

conversation = []
("AI Chat started. Type

while True:

user input =

if user input.lower ()
("Goodbye!")

break

conversation.append ({

"role": "user",

"content": user input

)

response = client.responses.create (
"gpt-4.1l-nano",
=conversation

response.output text

("AI:", ai reply)

conversation.append ({
"role": "assistant",
"content": ai reply

})



3. Run the code, verify it's working by asking any question:

Enter your prompt (or 'exit' to quit): what is Open AI API Key?
AI: OpenAI API Key is a unique authentication key provided bs
eading artificial intelligence research lab, that allows dex
ecurely access and use their AI models and tools through t
Application Programming Interface). The API Key acts as a secure token

O

at verifies the identity of the user and grants them acce
resources and services p ided by
to integrate OpenAl's powerful AI capabilities into their own
applications, 5, and services.

Enter your prc C 'exit' to quit):

OpenAI. Developers can u

Task 2: Create a Python AWS Lambda
function

In this task, we will write a lambda function in python, based on the code we wrote
in task 1.

1. Write the next AWS Lambda function in python code:
Import the OpenAl library:
1. Import necessary libraries:
1. Import the “json ™ module for handling JSON data.
2. Import the OpenAl class from the openai library to interact
with the OpenAl API.
o Define the Lambda handler function:
1. Create a function named "lambda_handler " that takes "event ™ and
‘context® as parameters.
Initialize the OpenAl client:
1. Create an instance of the "OpenAl " client using your API key.
o Parse the Request Body:
1. Try to parse the body of the event as JSON. If parsing fails, return a
400 status code with an error message.
2. Extract the user_prompt from the parsed bodly.
o Validate the user prompt:
1. Check if the "user_prompt " is present. If not, return a 400 status
code with an error message.
o Prepare the Conversation History:
1. Initialize an empty list for conversation_history.
2. Append the user_prompt to the conversation_history.
Generate a response from the Al:

O

O

O



1. Use the ‘client.responses " method of the OpenAl client to generate
a response based on the conversation history.
o Return the Al's response:
1. Return a 200 status code with the Al's response in the body.
o Use a low-cost model like ‘gpt-4.1-nano” model



2. Alternatively, use the following code, make sure to replace
with your own key:

import json
from openai import OpenAI

def lambda handler (event,

client = OpenAlI (

try:
body = json.loads (event.get ("body", "{}"))
except Exception:
return {

atusCod 5

ly": Jjson.dumps ({"error": "Invalid JSON in request

user prompt = body.get ("user prompt")

if not user prompt:
return {

" o ~

S ek g ,

json.dumps ({"error

"Missing 'user prompt'

conversation history = []

conversation history.append ({
"role": "user",
"content": user prompt

response = client.responses.create (
="gpt-4.1l-nano",
=conversation history

al reply = response.output text

Json.dumps ( {
': ai reply

"response":

except Exception




. In AWS Management Console, In the search box to the right of Services,
search for and choose Lambda to open the AWS Lambda console.

. Choose Create a function.

. In the Create function screen, configure these settings:

o Choose Author from scratch

o Function name: open-ai-python-3-12

o Runtime: Python 3.12

o Choose Change default execution role

o Execution role: Use an existing role

o Existing role: From the dropdown list, choose LabRole

. Choose Create function.

. The below should appear.

open-ai-python-3-12

v Function overview info

‘ open-ai-python-3-12



Task 3: Configure the Lambda function

In this task, you will paste the lambda function code you wrote in task 2.

12.Below the Function overview pane, choose Code, and then choose
lambda_function.py to display and edit the Lambda function code.

13.In the Code source pane, delete the existing code, and paste the code you
wrote in task 2.

14.By default, file saving is marked as Auto Save. To verify this, Choose the File
menu and look for the V next to the Auto Save option.

e
= File > Mew Text File Ctrl+K N
Edit » New File... Ctrl+Alt+Windows+N
IQ Selection b )
Open File... Ctrl+0
p View »
Go 5 v Auto Save
|-> Help Y Preferences >
£
Close Editor Ctrl+F4
=5

Confirm Before Close

Alternatively, Save the changes.
14.1n the Code source box, choose Deploy.

Your Lambda function is now fully configured.

® Successfully updated the function open-ai-python-3-10



Task 4: Verify that the Lambda function
works

19.Choose Test tab, and update the next JSON in the Event JSON panel:

20.Press on Test. The function will execute, and error will occur:

@ Executing function: failed (logs [7)
w Details

The area below shows the last 4 KB of the execution log.

1
"errorMessage”: "Unable to import module 'lambda_function': Mo module named 'openai'",
"errorType™: "Runtime.ImportModuleError”,
"requestId”: "“,
"stackTrace™: []
b

The error message "Unable to import module 'lambda_function': No module
named 'openai' indicates that the AWS Lambda environment cannot find the
openai module. This happens because the openai package is not included in
the deployment package. In the next task, we will resolve this.

Task 5: Create AWS Lambda layer for openai

We will use a pre-created openai lambda layer zip file which supports python 12.

openai-2.24.0-layer-python-12.zip



Task 6: Configure AWS Lambda layers

In this task you will solve the issue with missing dependencies using AWS Lambda
layers.

1. In the Lambda Function overview pane, you will see that there is currently
no layer.

open-ai-python-3-12

v Function overview info

‘ open-ai-python-3-12

<= Layers
‘_v R

-1

2. Inthe Lambda Function overview pane, you will see that there are currently
no Layers. Press on the Layers link to navigate to the Layers pane:

% Layers (Q)

-

3. Inthe Layers pane, press on Add a Layer.

Layers Info ( Edit ) ( Add a layer )

Merge order Name Layer version Compatible runtimes Compatible architectures Version ARN

There 15 no dats to display.

19.1n the Add layer page, in the Choose a layer pane, press right click on the
create a new layer link, and select Open link in new tab.

Choose a layer
Layer source Info


https://us-east-1.console.aws.amazon.com/lambda/home?region=us-east-1#/create/layer

20.Navigate to the new tab, and In the Create layer window, set the Name as
openai-layer, press on the Upload button, and select the openai-lambda-
layer.zip file. Select the Compatible runtimes drop down, select Python 12,
and press Create. Your layer has now successfully created.

® Successfully created layer openai-layer version 1.

21.Navigate back to the Create layer window and refresh the page (F5), in the
Choose a layer pane, select the Custom Layers radio button. Then, open
the Custom Layers drop down and select openai-layer, and in the Version
drop down, select 1, and press on Add.

Choose a layer

Layer source  Info

hoose from Lyers with 3 cosmpatible runtime and instruction set architecu ar specify the Amgzon Rasource Naeme (ARN) of 3 yer varsion. Y CaN S50 Rate 3 naw layer
AWS layers © Custom layers
Choose 8 layer from a Int of layers provided by AWS Choose o layer from 2 ist of layers createt! by your AWS account
Custom layers
Layers cmated by your NS account that are compatibile with your function

open-ai-layer-2_24 0

Version

1



Task 7: Re Verify that the Lambda function
works

19.Choose Test tab, and update the next JSON in the Event JSON panel:

20.Press on Test. The function will execute and will finish successfully.

22.Press on the Details drop down and inspect the execution. You should see
the response, Summary and Log output where you will also see the reply of
the OpenAl API:
{
"statusCode": 200,
"body": "{\"ai_reply\": \" | am an Al digital assistant designed to provide
information and assist with various tasks. How can | help you today?\"}"

)

@ Executing function: succeeded (logs ()
¥ Details

The arca below shows the last 4 KB of the execution log.

“stotusCode”: 200

"Body™: "(\"al_reply\": \"1 am an Al digital ssslatant designed to provide Information end sesist with vericus tasks. How zan I helg yeu today\")"



Task 8: Execute the Lambda function from a
Web Browser web address URL.

15.Choose Configuration tab, Function URL (a dedicated HTTP(S) endpoint)
option and press on Create Function URL.

Code Test Monitor Configuration Aliases Versions

e o Function URL 1.

No Function URL

Pormmicucns No Function UL = configured

Croate function URL

16.In the Configure Function URL section, under Function URL section select
None

Configure Function URL

Function URL 1o
Use function URLs to assign HTTP(S) endpoints to your Lambda function.

Auth type
Choose the auth type for your function URL. Learn more (A

AWS_IAM
Only authenticated |1AM users and roles can make requests to your function URL.

O NONE

Lambda won't perform IAM authentication on requests to your function URL. The {

17.0pen the Additional settings section and select
Configure cross-origin resource sharing (CORS)

v Additional settings

Invoke mode | Info
Choose how your function returns responses. Learn more |2

© BUFFERED (default)

The invocation results are available when the payload is completi

() RESPONSE_STREAM

Stream the invocation results. Streaming responses incurs additic

Configure cross-origin resource sharing (CORS)
Use CORS to allow access to your function URL from any domain.



18. Press Save. Your Function URL should now be created.

Function URL 10

[ () Your function URL is public. Anyone with the URL can access your function.

Function URL Auth type
Ej NONE

https://ynd4h2i5m6m5n3vguwdpb3ehaweOfvtnw.lambda-
url.us-east-1.on.aws/ |2

Creation time Last modified
3 seconds ago 3 seconds ago
CORS

Allow origin Expose headers

Max age Allow credentials

- false

19.Copy your function URL, and from your preferred web browser, execute it.
You should probably get an error of missing user_prompt parameter.

Note: You might get a different error depending on your function error
handling.

Pretty-print []

{"error"™: "user_prompt is required"}

Because our Lambda function supports POST request, we cannot execute it
by copying and pasting the URL into a browser's address bar like with a GET
request. POST requests require a request body, which cannot be included in
a URL.



Task 9: Execute the Lambda function from
postman.

1. Open postman.com and select to Send an API request.
Get started

Send an APl request
; i and test any type of AP request: HTTP, GraphQL, gRPC, WebSaocket, Socket.lO, or MQTT

New Request

2. Set the request type to POST.
Enter the URL of your deployed Lambda function endpoint.
4. Set the headers:
Key: Content-Type
Value: application/json
5. Set the body of the request to raw JSON and include the following content:

w




Task 10: Execute the Lambda function from
an HTML page.

1. Create a basic HTML page that will execute your lambda function. HTML page
will implement a basic chat window. Make sure to execute POST method

when calling your Lambda function.

You can use the next prompt:

create a basic chat HTML that will call AWS Lambda function.
1. It will use a lambda function in the next URL:

https://yn4h2i5mém5n3vguw4pb3ehawelfvtnw.lambda-url.us-east-
1.on.aws/

2. the lambda function will get the user prompt in a parameter
called: user_prompt

3. the Lambda function support POST request only

Alternatively, use the following code. Make sure to replace the <Aws Lambda
Function URL> to your own AWS Lambda Function URL.

<!DOCTYPE html>
<html lang :
<head>
<meta charset
<meta name content
<title>MTA Chat</title>
<style>
body {
font-family: Arial, sans-serif;
display: flex;
flex-direction: column;

align-items: center;
justify-content: center;
height: 100vh;

margin: 0;
background-color: #f4f4f4;

.chat-container {
width: 50%;
max-width: 600px;
background: white;
padding: 20px;




border-radius: 10px;
box-shadow: 0 0 10px rgba (0,
}
.chat-box {
height: 300px;
overflow-y: auto;
border-bottom: lpx solid #ccc;
margin-bottom: 10px;
padding: 10px;
}
.input-container {
display: flex;
}
input {
flex: 1;
padding: 10px;
border: lpx solid #ccc;
border-radius: 5px;
margin-right: 10px;
}
button {
padding: 10px 15px;
border: none;
background: blue;
color: white;
border-radius: 5px;
cursor: pointer;
}
</style>
</head>
<body>
<div class="chat-container">
<h2>MTA Chat</h2>
<div class="chat-box" id="chat-box"></div>
<div class="input-container">
<input type="text" id="user-input" placeholder="Type your
." autofocus>
<button id="send-btn">Send</button>
</div>
</div>

<script>
document.getElementById ("user-input") .addEventListener ("keypress",
function (event) {
if (event.key === "Enter") {
document.getElementById ("send-btn") .click() ;

});

document.getElementById ("send-btn") .addEventListener ("click", async
function () {
const userInput = document.getElementById ("user-input") .value.trim() ;
if (!'userInput) return;

const chatBox = document.getElementById("chat-box") ;
chatBox.innerHTML += “<div><strong>You:</strong> ${userlInput}</div>";
document.getElementById ("user—-input") .value = "";




{
const response = await fetch ("
method: "POST",
headers: {
"Content-Type": "application/json"

by
body: JSON.stringify({ user prompt: userInput })

});

(!response.ok) {
throw new Error ( HTTP error! Status: ${response.status}’);

}

const data = await response.json() ;
chatBox.innerHTML += “<div><strong>AI:</strong>
${data.ai reply}</div>";
chatBox.scrollTop = chatBox.scrollHeight;
} catch (error) {
console.error ("Fetch error:", error);
chatBox.innerHTML += "<div style="color:
red; "><strong>Error:</strong> ${error.message}</div>";
}
});
</script>
</body>
</html>

2. Open the HTML page, add the parameters values and execute it. You should
get an error: ChatGPT: Unable to connect to the server.

You: who are you?
ChatGPT: Unable to connect to the server.

This is due to CORS Policy. Our Lambda function is not supporting to allow
cross-origin requests. When you call a Lambda function directly from a web
browser by entering the URL, it works because the browser does not enforce
Cross-Origin Resource Sharing (CORS) policies for direct URL access.
However, when you call the Lambda function from an HTML page using
JavaScript (e.g., fetch), the browser enforces CORS policies to prevent security
issues. Let's fix this.



3. Add support to CORS headers in the Lambda function from Function URL
Configuration.

o Inthe AWS Lambda function window, Choose Configuration tab,
Function URL and Edit.

Configuration Allases Versanm

Function URL . 1:‘- Detes ) (2

‘ () oo Stesion LRI I puliic, Avynon with e LS. can scom your function

o Inthe Additional settings section:
o Make sure that Allow origin has the value of *.

Allow origin
Add the origins that can acces

| B

( Add new value )

o Setthe Allow headers to * by pressing Add new value.

Allow headers
Choose the HTTP headers that ori

‘ "

( Add new value )




o Open the Allow methods drop down, and select POST

Allow methods
Choose the HTTP methods that

] Optional - choose one or |

POST X

o Press Save. Your Function URL should now be updated.

CORS

Allow origin Expose headers Allow headers Allow methods
* % % POST

Max age Allow credentials

- false

4. Re Open the HTML page and execute it. IT should now work:

You: who are you?

ChatGPT: I am a language model AT assistant here to help and

provide information to the best of my abilities. How can I assist
you today?

Type your message here. .




Note: Alternative option for core support, instead of Function URL

configuration is to change the lambda code to support it.
o Step 1, set headers dictionary:

# CORS headers
'Access-Control-Allow-Origin': '*'

'Access-Control-Allow-Methods': 'OPTIONS,POST'
'Access-Control-Allow-Headers': 'Content-Type'

o Step 2, if HTTP method is OPTIONS, return 200:

if "requestContext" "http" "method"
return
"statusCode": 200
"headers"
Ilbodyll nn
o Step 3, add 'headers' to all returns, example:
return
"statusCode": 200
'headers'

"body" "ai_reply"

"OPTIONS"



Task 11: Create Python chat using lambda
function

In this task, you will write a Python program that interacts with a lambda function to
generate responses based on user input.

1. Write a python script that will implement a chat using an AWS lambda function
(Which calls open Al API) that support HTTP Method POST.
Alternatively, use the following code, make sure to replace
with your lambda function URL:

lambda url = LAMBDA FUNCTIO

conversation history = []

while True:
user prompt = ("Enter your prompt
'

if user prompt.lower () == oxit':
break

conversation history.append({"role

response.raise for status ()
data = response.json ()

"

al reply = data["ai reply"]
pt requests.exceptions.RequestException as e:
("H 7

continue

{e}l")

("AI:", ai reply)
conversation history.append ({

2. Run the code, verify it's working by asking any question:

Enter your prompt (or 'exit' to quit): hello
Al: Hello! How can | assist you today?
Enter your prompt (or 'exit' to quit):



Task 12: Enhance the Lambda function to
support conversation history

At this point, the Lambda function is not supporting conversation history, so open-
ai will not reply to the prompt based on session context. As Lambda function is
stateless, we will now add DynamoDB table to keep the conversation history and
enhance the Lambda function to read and write to the table per needs. In addition,
we will enhance the HTML page to pass to the Lambda API user_id.

1. Create a DynamoDB Table.
o Inthe AWS Console search box to the right of Services, search for and choose
DynamoDB to open the DynamoDB console.
o Choose Create table.
o Inthe Create table screen, configure these settings:
1. Table name: chat-history: A clear name representing stored chat
messages.
2. Partition key name: user_id (String): Groups messages by user.
3. Sort key name: timestamp (Number): Ensures messages are ordered
chronologically per user.

Create table

Table d!lails info

DynamoDB is a «chemaless database that requines only a table name and a primary key when you create the table
Table name
His will be . 1 tat

| chat-history

Yot mee ey an W5 tharpcters Intaining geey lette sambiers, undersioess | |, hygihe

Partition key

| user_id String

14

Sort key - optional
JLan | ] e he seCam LR 1l pramary ey, The sort bey ollows yond i it Of search amang all item )

| timestamp | Number

11

o Choose Create table.
o The table will now be created, this operation might take a few minutes.

¢ Creating the chat-history table. It will be available for use shortly.




o Once the table is ready to use, the following message will appear:

@ ' s Atnrsey tedke wan et s Aty x

Tables © . FomaTow

2. Enhance the Lambda function to support conversation_history using Dynamo DB:
In addition to 'user_prompt', it will also get 'user_id'".
It will create a resource to 'dynamodb’ to table: 'chat-history".
It will read the last 6 messages from a DynamoDB table and send it to
open-ai APl sorted by timestamp using the conversation_history
List.
I will then save the last prompt and reply in the table. Remember also to
get from the body the user_id value which is needed for the table.

Alternatively, use the following code, make sure to replace < OPEN_AI_API_KEY>
with your lambda function URL:

8
8
t
O

penai import OpenAl
client = OpenATI ( =

dynamodb = boto3.resource (
table = dynamodb.Table (

def lambda handler (event,

body = json.loads (event.get (
S .

return {

14

Json.dumps ( {

}
user prompt = body.get (
user id = body.get ( )

if not user prompt or not user id:
return {

4

Json.dumps ( {




response table.query (
=boto3.dynamodb.conditions.Key ('user id') .eqg(user

=False,

items = response.get ("Items", [])

items sorted = =lambda x: x["timestamp"])

conversation history = []

for item in items sorted:
conversation history.append ({
"role": item["role"],
"content": item["content"]

})

conversation history.append ({
"role": "user",
"content": user prompt

)

al response = client.responses.create (
="gpt-4.l-nano",
=conversation history

al reply = ai response.output text

timestamp = (time.time ())

table.put item(

user id,
timestamp,

ser"

ser",

"content": user prompt




table.put item(

user id,
timestamp + 1,

"content": ai reply
)
return {

son.dumps ( {
ai reply

ssponse":

3. Choose Test tab, and use the next 4 prompts, one by one, to test your code:

ser prompt

ser prompt

ser prompt

4. Verify the last reply you got:

{
"statusCode": 200,

"body": "{\"response\": \"You asked, \\\"How much is 4+42\\\"\"}" }



5. Verify the content of DynamoDB Table:

user_id {String) v timestamp (Number) v | content v role
1742155620204 1417 user
1742153620205 o122 assistant
1742153631876 2422 usar
@ 1742153631877 242=4 assistant
1742153641787 Je 352 user
1742153641788 3+3=% assistant
7} 1742153650260 447 usey
1742153650261 4+4:8 assstant
1742153662156 what was my last question? LSer
1742153662157 Your last guestion was “d+47™ assistanm

6. Enhance the HTML chat page to send also the user_id. You can select one of the
next 3 options:
Hard code the user_id value
Generate a random user_id
Ask the user for his name and use it as a user_id

Alternatively, use the following code which generates a random user_id.
Make sure to replace the <Aws Lambda Function URL> to your own AWS Lambda
Function URL.

<!DOCTYPE html>
<html lang
<head>

_n ~

en">
<

vice-width, initial-

font-family: Arial, sans-serif;
display: flex;
flex-direction: column;
align-items: center;
Justify-content: center;
height: 100vh;
margin: 0;
background-color: #f4fdf4;
}
.chat-container ({
width: 5
max-width: 600px;
background: white;




padding: 20px;
border-radius: 10px;
box-shadow: 0 0 10px rgba (0,
}
.chat-box {
height: 300px;
overflow-y: auto;
border-bottom: 1lpx solid #ccc;
margin-bottom: 10px;
padding: 10px;
}
.input-container {
display: flex;
}
input {
flex: 1;
padding: 10px;
border: 1lpx solid #ccc;
border-radius: 5px;
margin-right: 10px;
}
button {
padding: 10px 15px;
border: none;
background: blue;
color: white;
border-radius: 5px;
cursor: pointer;
}
</style>
</head>
<body>
<div class="chat-container">
<h2>MTA Chat</h2>
<div class="chat-box" id="chat-box"></div>
<div class="input-container">
<input type="text" id="user-input" placeholder="Type your
." autofocus>
<button id="send-btn">Send</button>
</div>
</div>

<script>

document.getElementById ("user-
input") .addEventListener ("keypress", function (event) ({
if (event.key === "Enter") {
document.getElementById ("send-btn") .click() ;

});

document.getElementById ("send-btn") .addEventListener ("click",




function () {

const userInput = document.getElementById("user-
input") .value.trim() ;

if ('userInput) return;

const chatBox = document.getElementById("chat-box") ;

chatBox.innerHTML += “<div><strong>You:</strong>
$S{userInput}</div>";

document.getElementById ("user-input") .value = "";

try {
const response = await fetch ("<Z ambda Function URL>", {
method: "POST",
headers: {
"Content-Type": "application/json"

}y
body: JSON.stringify ({
user prompt: userInput
})
}) i

(!'response.ok) {
throw new Error ( HTTP error! Status: ${response.status}’);

const data = await response.json() ;
chatBox.innerHTML += ‘<div><strong>AI:</strong>
${data.ai reply}</div>";
chatBox.scrollTop = chatBox.scrollHeight;
} catch (error) {
console.error ("Fetch error:", error);
chatBox.innerHTML += "<div style="color:
red; "><strong>Error:</strong> ${error.message}</div>";
}
}) s
</script>
</body>
</html>




7. Ask the 4 questions as noted above and verify the last one is correct:

MTA Chat

You: 1+1="7

Al: 1+ 1 equals 2.

You: 2+2=7

Al: 2 + 2 equals 4.

You: 3+3="7

Al: 3 + 3 equals 6.

You: 4+4=7

Al: 4 + 4 equals 8.

You: what was my last question?
Al: Your last question was: 4+4="

[Type your message... I

8. Similarly, review your table:

( E364d864-5684-4b27.-50dd-04 1 2d0ac4 28a 1742154408633 191=2 usr
[ [ 1742154408634 1+ Toquals 2 oe assistant
L F 1742154411613 242=7 Ser
. f 1742154411614 2+ 2equals 4 assistant
[ 6a64dB864-5688-4027-90dd-04 1 ZdDacd 2 Ha 1742154414790 343+7 uses
[ G354B64-5688-4b27-30dd-04 1 23004 284 1742154414790 3+ 3equals 6 assistant
& Gab4dEH0-SH8R-a027-90dd-04 1 2000ca 2 1742154418607 447 user
| Gt ddBOY-S688-4027-90dd-04 1 2d0acd 2 a 1742154418608 4+ dequals 8 assistant
O BabadB6d- 56884027 S0dd-04 12d00c8 262 1742154427795 what was my last question? user
a Babadibd- S688.4027 -50dd-04 12dbacd 2a 1742154427796 Your last question was: 4+4=7 assistant

Activity complete

Congratulations! You have completed the activity.



